
Copyright 2009, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 
 

 

 

 

 

Sol Server 

User’s Guide 

 
Release 2.0 

September 2010 
  



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

2 

 
 
Introduction 
This manual serves as a simple setup and installation guide to getting your display 

working quickly using the Mersive Sol Server with a Mersive Enabled Application. 

 

Table of Contents 

1 General Overview ....................................................................................................... 7 

2 Before Getting Started ................................................................................................ 8 

3 Client Software Installation......................................................................................... 8 

3.1 Windows Clients ................................................................................................... 9 

3.2 Linux Clients ......................................................................................................... 9 

4 Display Layout Setup ................................................................................................... 9 

4.1 Set Up Display Surface ......................................................................................... 9 

4.2 Arrange Projectors ............................................................................................... 9 

5 Hardware Connections ............................................................................................. 10 

5.1 Setup Connections on the Camera..................................................................... 10 

5.1.1 Option 1: Standard Connection .................................................................. 11 

5.1.2 Option 2: Pan-tilt Connection ..................................................................... 11 

5.2 Setup Connections on the Sol Server Machine .................................................. 12 

5.3 Set Up Connections on the Client Computers ................................................... 13 

6 Running the Sol Server .............................................................................................. 14 

6.1 EULA ................................................................................................................... 14 

6.2 Licensing ............................................................................................................. 15 

7 Sol Server Configuration ........................................................................................... 15 

7.1 Single Display ...................................................................................................... 16 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

3 

7.2 Multi-Display ...................................................................................................... 17 

7.2.1 Stereo Pair ................................................................................................... 18 

7.2.2 Camera ........................................................................................................ 19 

7.2.3 Pan-Tilt Sequence ....................................................................................... 19 

7.3 Verify Sol Server IP Address ............................................................................... 19 

7.4 Select your Display ............................................................................................. 19 

7.5 Add Clients to the Display .................................................................................. 20 

7.6 Edit Client Information ....................................................................................... 20 

7.7 Remove Clients from the Display System .......................................................... 23 

7.8 Test Client Connections ...................................................................................... 23 

8 Define Projector Outlines: Mask Tool ....................................................................... 24 

8.1 Start Mask Tool .................................................................................................. 24 

8.2 Select Channel .................................................................................................... 25 

8.3 Define Projector Outline .................................................................................... 25 

8.4 Save Settings and Exit......................................................................................... 27 

9 Camera Adjustments ................................................................................................ 27 

9.1 Test Camera Connection .................................................................................... 27 

9.2 Position and Orient the Camera ......................................................................... 28 

9.3 Adjust Camera Settings ...................................................................................... 29 

9.4 Troubleshooting ................................................................................................. 29 

10 Pan-Tilt Unit (PTU) .................................................................................................... 30 

10.1 Using the Pan-Tilt Unit Interface to Capture Multiple Views ......................... 30 

10.1.1 Multiple Displays ......................................................................................... 33 

10.2 Pan-Tilt Unit Tips ............................................................................................ 34 

11 Advanced System Settings ........................................................................................ 35 

11.1 Color Alignment/Warp Parameters ................................................................ 35 

11.1.1 Alpha Noise Coefficient ............................................................................... 35 

11.1.2 Automatic Color Alignment (choose one) ................................................... 35 

11.1.3 Blend Zone Brightness Enhancement ......................................................... 36 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

4 

11.1.4 Clip Planes ................................................................................................... 36 

11.2 Camera Details ................................................................................................ 37 

11.2.1 60Hz Shutter Mode ..................................................................................... 37 

11.2.2 Camera/Lens Parameters ........................................................................... 37 

11.3 Image Border .................................................................................................. 38 

11.3.1 Soft Edges (choose one) .............................................................................. 38 

11.4 Network .......................................................................................................... 38 

11.5 Pattern Generation ......................................................................................... 39 

11.5.1 Grid Resolution (choose one) ...................................................................... 39 

11.5.2 Target Size (choose one) ............................................................................. 39 

11.6 Physical Setup ................................................................................................. 40 

11.6.1 Display Surface Model (choose one) ........................................................... 41 

11.6.2 Eyepoint position ........................................................................................ 41 

11.6.3 Pan Tilt Manual Resolution ......................................................................... 41 

11.6.4 Pan Tilt Port (choose one) ........................................................................... 42 

11.6.5 Pan Tilt Rotation Angle ............................................................................... 42 

11.6.6 Pan Tilt Rotation Axis .................................................................................. 42 

11.6.7 Pan Tilt Software/Hardware Limits (choose one) ....................................... 42 

11.6.8 Pan Tilt Translation ..................................................................................... 43 

12 First Calibration ......................................................................................................... 43 

12.1 Before Calibrating ........................................................................................... 43 

12.2 Calibrate the Display ....................................................................................... 43 

12.3 Verify Calibration Results ............................................................................... 44 

12.4 Stop the Test Pattern Program ....................................................................... 45 

12.5 Calibration Report .......................................................................................... 45 

13 Automatic Color Alignment System .......................................................................... 46 

13.1 Static Gamma.................................................................................................. 46 

13.2 ICC Color Profiles ............................................................................................ 47 

13.2.1 Instructions for Use ..................................................................................... 47 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

5 

13.2.2 Troubleshooting .......................................................................................... 47 

13.2.3 Tips .............................................................................................................. 48 

13.3 Camera-based Color Alignment...................................................................... 48 

13.3.1 Instructions for Use ..................................................................................... 48 

13.3.2 Tips .............................................................................................................. 49 

14 World Alignment ....................................................................................................... 49 

14.1 Start World Alignment Tool ............................................................................ 49 

14.2 Adjust Orientation and/or Field of View (FOV) .............................................. 49 

14.3 Save Orientation and/or Field of View ........................................................... 49 

14.4 Stereo Displays ............................................................................................... 50 

14.5 Exit .................................................................................................................. 50 

15 Running an Application ............................................................................................. 50 

15.1 Integrated Application Compatibility ............................................................. 51 

15.2 Example .......................................................................................................... 51 

16 Using the Image Viewer ............................................................................................ 53 

16.1 Start Image Viewer ......................................................................................... 53 

16.2 Select Shape .................................................................................................... 53 

16.3 Select Directory of Images .............................................................................. 54 

16.4 Position Image ................................................................................................ 54 

16.5 Adjust Image Size ............................................................................................ 54 

16.6 Playback .......................................................................................................... 54 

16.7 Exit .................................................................................................................. 54 

17 Create/Restore Migration File .................................................................................. 55 

17.1 Create Migration File ...................................................................................... 56 

17.2 Restore Migration File .................................................................................... 56 

18 Troubleshooting ........................................................................................................ 57 

18.1 Rebooting the Sol Server ................................................................................ 57 

18.2 Camera Image Torn ........................................................................................ 57 

18.3 Camera Not Detected ..................................................................................... 57 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

6 

19 Contacting Mersive ................................................................................................... 57 

19.1 Email ............................................................................................................... 57 

19.2 Send Diagnostic Information to Mersive ........................................................ 58 

20 User Notes................................................................................................................. 59 

 

  



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

7 

1 General Overview 
Outlined below are the basic steps used to set up and run a display using the Mersive 

Sol Server with a Mersive Enabled application.  The rest of the manual describes each 

step in more detail. 

 

STEP 1: 

Install Software on Clients 
 

STEP 2: 

Assemble Display Components 

and Connect Hardware 

 

STEP 3: 

Configure Sol Server 

 

STEP 4: 

Adjust Calibration Camera 

 

STEP 5: 

Calibrate Display 

 

STEP 6: 

Run Mersive Enabled 

Application 
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2 Before Getting Started 

Before setting up the display, make sure you have each of the components listed below.   

 

The following items come shipped with the Sol Server System: 

 

� Manuals: 

• Sol Server User’s Guide 

• Sol RealTime API OpenGL User’s Guide 

• Pan-Tilt Unit User’s Manual (If Applicable) 

 

� Sol Server Machine with power cord 

 
� Point Grey Research (PGR) Firefly MV camera 

with USB Cable, C-Mount Camera Lens  

� Pan-Tilt Unit (If Applicable) 

 

� Mersive License Key 
 

 

In addition to the components above, you will need the following: 

� Monitor, Keyboard, and Mouse to connect to the Sol Server Machine 

� Digital Light Projectors (or other end display hardware) 

� Client Computers (Image Generators) that connect to the end display hardware 

� Network Switch 

� Ethernet Cable for the Sol Server 

� Ethernet Cable for each Client Computer 

3 Client Software Installation 
Both Windows and Linux clients are supported.  The following sections explain how to 

install the necessary software for each operating system. 

IMPORTANT:  Software installation must be performed for each Client 

Computer. 
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3.1 Windows Clients 

If using the Windows platform for your client machines, you will need to download the 

following software packages from: 

 

 http://www.mersive.com/Support 

 

• solclient_XP32_InstallGuide_<version>.pdf 

• solclient_XP32_<version>_b<build>.zip 

• solRealTimeAPI_XP32_<version>_b<build>.zip 

 

These are the Windows client-side installation instructions, client tools, and the 

RealTimeAPI SDK.  The install guide contains the details on how to install this software.  

At this time, there is only support for 32-bit application integration.  These 32-bit clients 

can however be used on 64-bit windows clients. 

3.2 Linux Clients 

If using the Linux platform for your client machines, you will need to download the 

following software packages from: 

 

 http://www.mersive.com/Support 

 

• solclient+RealTimeAPI_L32_InstallGuide_<version>.pdf 

• solclient+RealTimeAPI_L32_<version>.tar.gz (32 bit Linux) 

• solclient+RealTimeAPI_L64_<version>.tar.gz (64 bit Linux) 

 

These are the 32/64 bit Linux client-side applications (required for calibration), and the 

RealTimeAPI SDK.  The install guide contains the details on how to install this software. 

4 Display Layout Setup 

4.1 Set Up Display Surface 

Set up the display surface at the desired location. 

In the example below, a curved screen is used for the display surface. 

4.2 Arrange Projectors 

Position and orient the projectors to the desired configuration. 
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In the example below, projectors are configured to cover the semi-circle and 

are directed towards the display surface to create a front projection system. 

TIP: In general, it is recommended that there is a minimum of 10% overlap 

between adjacent projections on the display surface.  Although this is not 

required, blending results in overlap regions that fall significantly under this 

range may be compromised during calibration.  Note that it is okay if a 

projector’s area of projection oversprays past the display surface.  As detailed 

in an upcoming section, the desired area of rendering can be adjusted using 

the Mask Tool.   

Tip:  If your projectors have a sRGB option, it will typically produce the best 

results.  This is particularly true if you are utilizing Mersive’s Automatic Color 

Alignment System. 

Tip:  If using DLP projectors, turn off “white peaking” if there is an option to 

do so. 

 

  

Display Screen Overlap Between Projectors 

5 Hardware Connections 

5.1 Setup Connections on the Camera 

The Sol Server uses a PGR Firefly MV FMVU-13S2C camera to calibrate the displays.  

References throughout this document to camera apply to the FMVU-13S2C. 
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5.1.1 Option 1: Standard Connection 

If the entire display surface can be seen by a single camera from a fixed position, you 

will use this option. 

 

1. Mount the base of the camera onto a tripod. 

2. Plug the USB Cable into the back of the camera. 

 

5.1.2 Option 2: Pan-tilt Connection 

If the Standard Connection option does not fit your environment, you likely need to use 

a pan-tilt unit with a camera mounted on top.  This option describes that setup. 

 

The Pan-Tilt apparatus is made up of the Pan-Tilt Unit (PTU), the Pan-Tilt Controller, the 

Pan-Tilt Cable, a Power Supply, and an RS-232 Cable.   

 

 
  

      

Follow the proceeding steps to correctly set up the Pan-Tilt Unit.  For more detailed 

guidelines, please see the “Pan-Tilt Unit User’s Manual”. 

 

1. Mount the base of the Pan-Tilt Unit onto a tripod. 

2. Connect the Pan-Tilt Unit to the Pan-Tilt Controller using the supplied Pan-Tilt 

Cable.  (The smaller cable connector attaches to the Pan-Tilt Unit, and the larger 

cable connector attaches to the Controller box.)   

NOTE:  Failure to securely screw the cable connectors to the Pan-Tilt Unit and 

Controller can cause damage to the Controller when power is applied. 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

12 

3. Connect the RS-232 Cable to the Pan-Tilt Controller. 

4. Plug the Power Supply into the Pan-Tilt Controller and connect to a power 

source, but DO NOT TURN ON THE POWER until the RS-232 Cable has been 

plugged into the Sol Server Machine (as described in an upcoming step). 

5. Mount the Camera onto the Pan-Tilt Unit. 

IMPORTANT:  The camera body and lens should be oriented as shown in the 

image below. 

 
6. Plug the USB Cable into the back of the Camera. 

7. Use the knobs on the Pan-Tilt Unit to adjust its two motors so that both motors 

are parallel to each other and sit with the knobs facing the same direction.  Refer 

to the image to ensure proper alignment.   

NOTE: Do not manually rotate the Pan-Tilt axes.  Only move the Pan-Tilt Axes 

using the knobs located on the Pan-Tilt Unit motors.  Also note that this can 

only be done when the power is OFF on the Pan-Tilt Controller. 

5.2 Setup Connections on the Sol Server Machine 

1. Plug in the Sol Server power cord and connect to a power source. 

2. Plug in the Keyboard, Monitor, and Mouse. 

3. Plug the Mersive License Key into a USB slot. 

4. Plug the Ethernet cable into an Ethernet port, and then into your network. 

NOTE:  If you are using a rack-mount server, plug the Ethernet cable into the 

LEFT port (as you look at the server from the back). 

5. Plug the loose end of the USB cable connected to the Camera into the USB slot. 

6. If using a Pan-Tilt Unit with the Camera, plug the loose end of the RS-232 cable 

connected to the Pan-Tilt Controller into the RS-232 slot.   

NOTE:  If your Sol Server does not have a RS-232 slot, you will need a USB RS-

232 Serial Adapter.  When using a USB port to connect the PTU, you must go 

to the ”Advanced � System Settings” menu on the Sol Server and change 
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“Physical Settings → Pan Tilt Port”, to USB.  If you forget this step, the Sol 

Server will not see the Pan-Tilt Unit. 

 

7. If using a Pan-Tilt Unit with the Camera, power on the Pan-Tilt Controller. 

8. Power on the Sol Server by pressing the "On" switch. 

 

Back View 

 
 

Front View 

 
  

5.3 Set Up Connections on the Client Computers 

1. Connect the projectors to the Client Computers using the appropriate display 

cables. 

2. Plug an Ethernet cable into the Ethernet port of each Client Computer, and into 

your network. 

NOTE:  Make sure the Sol Server and Client computers are on the same 

network and can communicate with each other. 

3. Power on the client computers and projectors. 
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6 Running the Sol Server 
At this point, hardware connections between all components of the system have been 

made and the necessary software has been installed on all Client Computers.  It is now 

time to boot the Sol Server. 

 

6.1 EULA 

The first thing you will see when you boot the Sol Server is the End User’s License 

Agreement (EULA).  You may choose to bypass this screen on subsequent boots as you 

accept the license. 
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6.2 Licensing 

Your Mersive License Key must be inserted into the Sol Server before booting.  The 

license key determines how many Displays and Channels you may configure. 

 

The “Help � About License” menu option will show you the total number of Displays 

and Channels that you have access to. 

 

If you need any information about licensing, please contact us at sales@mersive.com.  

7 Sol Server Configuration 
It is now time to configure the Sol Server with the appropriate parameters in order to 

enable communication between the Sol Server and the Client Computers over the 

network.   

 

The Sol Server interfaces shown below will be used to configure the system and launch 

the calibration processes. 
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7.1 Single Display 

If you only have a single Display license, your interface will look like the following 

picture.  Since you only have one Display, your interface will not show the tabs that are 

seen in many of the screenshots used throughout this document.  You can safely ignore 

instructions specific to Multi-Display. 
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7.2 Multi-Display 

New in Sol Server 1.6.0 is the concept of Multiple Displays.  Each Display is composed of 

multiple Channels (effectively projectors), and keep track of their own configuration and 

calibration information.  Because of this, a single Sol Server on a network can serve 

multiple Displays. 

 

The interface below shows a setup with 3 different Displays.  The tabs are used to move 

between the Displays when you are doing your configuration. 

 

 

IMPORTANT: When the Sol Server is configured to support Multiple Displays, 

launching a command from the Sol Server interface operates on a per Display 

Tab basis.  So for example, if the currently selected Tab is Display2, then Mask 

Tool, Calibration, Test Pattern, and all other Tools on the Sol Server (including 
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all items under the Advanced menu option) will be operating only on those 

Channels that are configured in Display2. 

 

There are some special configuration settings that can be made for Multi-Display 

systems.  Select the “Multi-Display � Configure Parameters” menu option to configure 

those settings. 

 

 
 

From this dialog box, you can rename your Displays if you like.  Just double-click on the 

name, and type in the new name. 

7.2.1 Stereo Pair 

If you are setting up a passive stereo system, one Display will serve as the left eye and 

one Display will serve as the right eye.  You must link the left and right eye Displays with 

each other.  To do this for the left eye Display, use the drop down box under the 

“Stereo” column to select the corresponding right eye Display.  Then, do the same thing 

for the right eye Display (thus linking it to the left eye Display). 

 

Linking the left and right eye Displays serves the following functions: 

 

1) Run the Mask Tool in Stereo mode. 

2) Blank out one set of projectors in a Display while the other paired Display is 

undergoing calibration. 

3) Run the World Alignment Tool in Stereo mode. 
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7.2.2 Camera 

If multiple cameras are connected to the Sol Server, use the drop down box under the 

“Camera” column to assign a camera to each Display.  When you click on a camera 

name, a preview of that camera is shown in the “Camera Preview” window. 

 

When two Displays are set as a stereo pair, it is very likely that you will be using the 

same physical camera, so make sure you select the same camera for both Displays. 

7.2.3 Pan-Tilt Sequence 

We will discuss how the Pan-Tilt Sequences are set up in a later section.  Note that if you 

are not using a Pan-Tilt Unit with the Sol Server, you may ignore this section. 

 

For now you just need to know that if you are setting up more than one Display for the 

same physical environment (stereo or some other configuration where the same screen 

is used for two different purposes), you will likely want to use the same Pan-Tilt 

Sequence for both of those displays.  You can do that here. 

 

So for example, if you have two Displays set as a stereo pair, use the drop down box 

under the “Pan-Tilt Sequence” column to set the descriptor to “—Assign –“ for one 

Display, and then set the other Display’s Pan-Tilt Sequence descriptor to be the same as 

its corresponding pair.  By doing this, you only need to define a single Pan-Tilt Sequence 

that will be used for both Displays during calibration. 

 

Press “Save Configuration” once you are done making your changes.  

7.3 Verify Sol Server IP Address 

The Client Computers communicate with the Sol Server via the Sol Server's IP Address.  

A default IP Address comes already set on the Sol Server.   

 

If you need to change the default IP Address, right-click on the “Sol Server” label in the 

Configuration Window and select “Change IP Address”.  Type in the new IP Address and 

press enter. 

7.4 Select your Display 

If your system is licensed for more than one Display, you will see a tab for each Display.  

You simply select the tab of the Display you wish to work with.  As you go through the 

various steps for configuration/calibration described in the following sections, you need 
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to be sure you have the tab selected for the Display that you are working with 

(configuration and calibration is saved for each Display independently). 

7.5 Add Clients to the Display 

Each projector (also known as a Channel) connected to a Client Computer must have an 

entry in the Sol Server.  The Mersive License Key determines the maximum number of 

Channels that can be calibrated by the system.  This number is the second number 

shown next to the "Channels" label in the System Configuration window.   

 

To add a channel to the Sol Server system: 

 

• Right-click the "Channels" label in the Configuration Window and select "Add 

Channel" from the popup menu.  A new default channel appears in the “Channels” 

list with default IP Address and default Display ID.  Create a entry for each channel 

that will be in the Display. 

 

 

TIP: For the case where there is more than one Channel attached to a Client 

Computer, each of those Channels will share the same IP address.  However, 

the names of each Channel must be unique. 

7.6 Edit Client Information 

Modify each channel by right-clicking on the channel and select "Edit Channel" from the 

popup menu.  You will be prompted to provide the following information:    
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• Channel Name: 

Enter the name of the channel and press enter. 

• IP Address of Channel: 

Enter the IP Address of the Channel and press enter. 

• Display Server Number and Screen Number: 

The “Display ID” format is :X.Y, where X is the display server number and Y is the 

screen number on that server.  When editing, X is entered in one dialog box, 

while Y is entered in the next. 

 

For systems where a single projector is connected to the Client, display server 

number and screen number will both be 0 (and thus is displayed as :0.0 in the 

GUI). 

 

On Windows Client computers with more than one display, the display server 

number will be 0, and the screen number will be the number Windows gives the 

screen in Display Properties minus 1.  For example, 0:0 and 0:1 would refer to 

the first and second monitor on the Windows Client. 

 

In Windows, some graphics cards allow you to combine multiple displays into a 

single unified display.  An example would be two 1024x768 displays combined to 

create a 2048x768 screen.  In this case, Windows would report that as a single 

display in Display Settings.  You must configure Sol Server in a slightly different 

way in order for it to know how to split up the unified display into separate 

channels.  The Display Server Number would still be 0, but the screen number 

would be specified as follows: 

 

Y-cn-cm-rn-rm 

 

Where: 

 Y Screen Number - number Windows gives the screen minus 1 

 cn Column Number - column this channel is in within the display 

 cm Column Max - total number of columns across this display 

 rn Row Number - row this channel is in within the display 

   (leave blank with no ‘-‘s if there is only one row) 

 rm Row Max - total number of rows down the screen 

   (leave blank with no ‘-‘s if there is only one row) 
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Thus if you had 2 displays combined into a single 2048x768 screen that Windows 

Display Properties identifies as “1”, the 2 channels would have the following 

configuration: 

 

 Channel01 :0.0-1-2 

Channel02 :0.0-2-2 

 

This is saying that Channel01 is the left half of the unified display, and Channel02 

is the right half of the unified display. 

 

Some cards can merge more than just two displays into a unified display.  So if a 

card were capable of taking 6 displays in a 2x3 (two rows, three columns) unified 

display, and Windows reported the unified display as number 1, the 

configuration would look like the following: 

 

 Channel01 :0.0-1-3-1-2 

 Channel02 :0.0-2-3-1-2 

 Channel03 :0.0-3-3-1-2 

 Channel04 :0.0-1-3-2-2 

 Channel05 :0.0-2-3-2-2 

 Channel06 :0.0-3-3-2-2 

 

So if you look at Channel01, it is the 1st third of the unified display in width, and 

the 1st half in height (the upper left corner).  Channel05 is thus the 2nd third in 

width, and the 2nd half in height (the bottom middle piece). 

 

Note that on Linux-based systems using multiple X servers, the “server” field 

should be adjusted accordingly. 
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7.7 Remove Clients from the Display System 

To remove a channel from the system, right-click on the channel and select “Remove 

Channel(s)”. 

 

 

7.8 Test Client Connections 

Once you have configured all of the Clients and their Channels, test the connection 

between the Sol Server and those Client Channels by selecting the "Ping Clients" button 

on the Sol Server’s interface.  If the connection is successful, the “Ping Clients” button 

will remain green.   

 

If there is a connection error, the “Ping Clients” button will turn red, and an appropriate 

error message will be printed in the Messaging Window.  If this occurs, make sure all the 

Channel information has been correctly entered, and verify that the physical 

connections have been set up properly.  If you have not installed the Client Software, 

you would also get an error at this point. 
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8 Define Projector Outlines: Mask Tool 
For most setups it is helpful to outline (mask off), the boundaries of projectors 

participating in the display before calibration begins.  This can useful for preventing 

calibration and image rendering from occurring on projection areas that do not fall on 

the display surface (areas of overspray, for example), or for areas on the display surface 

that contain undesirable artifacts. 

8.1 Start Mask Tool 

If you are using a Multi-Display system, select the Display tab you wish to work on.  Then 

bring up the Mask tool by clicking the “Mask Tool” button on the Sol Server’s Control 

Panel. 

 

 
 

NOTE: You will normally only see one tab in the Mask Tool.  The only time you 

will see more than one tab, is if you’ve defined a stereo pair in the Multi-

Display configuration dialog.  In that case, you will see a tab for both the left 

and right eye Displays. 
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8.2 Select Channel 

Select a channel from the “Channel Name” list.  The window to the right of the list will 

show a bounding polygon that represents the current area of projection for this 

channel.  The associated projector simultaneously renders this polygon onto the display 

surface. 

 

You can select the “Show All” box in order to see the current mask for each of the 

Channels.  Here, it is sometimes useful to also select “Show Name”.  This allows you to 

easily identify each mask. 

 

If you have a stereo pair, you can also show the Channel masks of both Displays at the 

same time by checking the “Show Simultaneous Displays” box. 

8.3 Define Projector Outline 

Use the mouse to move the points and edges of the polygon to the desired location by 

pressing the left mouse button while dragging the point or edge.  To refine the polygon 

boundary, add points to the polygon by double-clicking the left mouse button on or near 

an edge.  A point is deleted from the polygon by right-clicking on the point. 

 

NOTE: If the mask for a Channel is not rotated on the interface, as it is on 

your screen, you can press the “Rotate 90” button as needed to correct the 

orientation. 

 

The goal is to mask each projection to your screen edges, as well as allow for roughly 

10% overlap between projections. 

 

This first picture shows how the projector outline has been created with multiple points 

to fit the mask.  The second picture shows how this looks on the actual screen.  The 

third picture shows how this looks when all masks are showing at the same time. 
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If you are setting up stereo, then you should take care to make sure the outside edges of 

the overall masked Displays line up with each other.  This ensures the left and right eye 

Displays are filling the same overall area.  You do not need to line up the masking of the 

left and right Display interior edges. 

8.4 Save Settings and Exit 

Once a bounding polygon has been defined for each channel, select "Save All 

Channels".  (Note that "Save All Channels" may be selected at any time while using the 

Mask Tool.)   Exit the Mask Tool by clicking the close icon located on the upper right 

corner of the interface, or by clicking the “Halt Mask Tool” button located on the Sol 

Server interface. 

9 Camera Adjustments 
If you are using a Multi-Display system, select the Display tab you wish to work on. 

9.1 Test Camera Connection 

Press the "Play" icon above the "Camera Settings" label in the Camera Preview window 

of the Sol Server interface to ensure that the camera is connected to the server and is 

able to capture video.  If the camera is not connected or cannot be recognized by the 

system, an error message will be printed in the Status Window. 
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NOTE: Unplugging the camera while the Sol Server is running may cause 

unexpected behavior.  If this occurs, you may have to restart Sol Server. (see 

“Restarting the Sol Server”). 

 

9.2 Position and Orient the Camera 

Position and orient the camera towards the display surface so that the display is in the 

field of view of the camera.  Although almost any camera position can be used for 

calibration, it is recommended to position the camera directly in front of the display 

(centered horizontally and vertically is ideal). 

 

If using the camera without a Pan-Tilt Unit, the camera should see the entire projected 

area of the display.  If using the camera with a Pan-Tilt Unit to acquire multiple views of 

the display surface, the camera should be facing the center of the projected areas.  (See 

images below for an example of each setup.) 
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Single View:  Camera (Not Shown) Sees Entire Area of Projection 

 

 
 

Multiple Views Using Pan-Tilt Unit:  Camera Sees Center of Projection Area 

9.3 Adjust Camera Settings 

•••• Adjust the physical aperture on the camera lens.  Start with the aperture closed 

down all the way and then gradually increase it until the image in the Camera 

Preview Window is bright but not washed out.  Secure the lock on the lens if 

applicable. 

•••• Using the Camera Controls on the Sol Server interface, adjust the Shutter Speed so 

that the Display screen is properly visible in the Camera Preview Window.  Gain 

should be set to the minimum. 

•••• Focus the image using the physical focus ring on the camera lens. 

9.4 Troubleshooting 

If the Sol Server loses contact with the camera, you will get a message indicating the 

camera was not detected.  Below the camera preview window, you will also see a 
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message asking you to re-connect the camera, and press play.  This will restart the 

camera server.   

 

If you’ve already done your calibrations, it is okay to have your camera disconnected, 

and in the state above.  If you need to calibrate again, simply reconnect the camera and 

press Play.  In some cases you would need to restart the Sol Server (File → Restart Sol 

Server), and in very rare cases you would need to reboot the Sol Server hardware itself. 

10 Pan-Tilt Unit (PTU) 
If you are not using a camera with a Pan-Tilt Unit, you can skip this section. 

10.1 Using the Pan-Tilt Unit Interface to Capture Multiple Views 

 

At this point, the Pan-Tilt Unit should have been properly set up as described in the 

Hardware Setup sections.  The Pan-Tilt Controller interface should have automatically 

appeared under the Camera Preview and Control Window when the Sol Server was 

started.  Secure the PTU and camera cables to the tripod to prevent entanglement 

during the calibration process. 

 

NOTE:  If the Pan-Tilt Controller interface did not automatically appear, make 

sure the PTU and camera cables are correctly connected, and restart the Sol 

Server by File → Restart Sol Server. (The PTU must be plugged in and turned 

on before the Sol Server is restarted.) 

NOTE:  If your Sol Server does not have a RS-232 slot, you will need a USB RS-

232 Serial Adapter.  When using a USB port to connect the PTU, you must go 

to the ”Advanced � System Settings” menu on the Sol Server and change 

“Physical Settings → Pan Tilt Port”, to USB.  If you forget this step, the Sol 

Server will not see the Pan-Tilt Unit. 
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When you can’t see the entire display surface with a single fixed camera, you use the 

Pan-Tilt Unit.  The Pan-Tilt Unit allows you to accurately aim the camera to various 

positions that you record.  In this way, you can piece together several views that will 

cover your entire display surface. 

 

Follow these guidelines to understand how to use the Pan-Tilt Unit.  These are only 

guidelines.  The important thing is that you completely cover your viewing surface with 

camera positions. 

 

•••• Start the Mask Tool and turn on all masks with Display names showing.  This isn’t 

required, but makes it easy to see what portion of the screen is visible by the 

camera.  You can move the Mask Tool to the side, and still operate the Pan Tilt Unit 

via the interface. 
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•••• To start fresh, delete any positions already in the sequence.  Do this by right clicking 

on the preview image and selecting “Delete Image”. 

•••• It is best to have your first position be close to the main viewing angle.  That means 

the best initial position would have a Pan value of 0 (assuming you have set up the 

camera to point at the middle of the screen when Pan is 0).  Adjust the Tilt down so 

the camera sees the bottom edge of the screen. 

•••• Press “Save Position”.  This will create an image preview in the “Current Sequence” 

window. 

•••• Now adjust the Pan and Tilt so that you aim the camera to the right of your first 

position.  Look at the preview window to make sure you have at least 10% overlap 

with the previous position. 

•••• Press “Save Position”.  This creates another image in the Current Sequence. 

•••• Continue in this fashion until you have recorded positions that fully cover the screen. 

NOTE:  You can move the camera to a recorded position by clicking on that 

image in the View Sequence. 

NOTE:  A saved position can be deleted from the sequence by right-clicking on 

the image in the View Sequence area and selecting “Delete Image”. 

NOTE:  If the preview images show “No Preview Available”, you can select the 

“Eye” button, and it will refresh the picture at each position. 

•••• After you’ve completed coverage of the entire screen, press the “Save Sequence” 

button. 

 

What this does is save the sequence of camera positions for the Display you have 

selected.  During calibration, the camera will go to each of these positions before it 

starts putting up calibration patterns. 
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10.1.1 Multiple Displays 

If you are using multiple Displays, and each refers to the same physical setup, you can 

share a single Pan-Tilt Sequence with another Display.  This would be the case for a 

stereo setup.  To do this, go into the “Multi-Display � Configure Parameters” dialog box 

and assign the second Display to the first’s Pan Tilt Sequence.  Then press the “Save 

Configuration” button. 
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10.2 Pan-Tilt Unit Tips 

• Overlapping Pan Tilt views should ideally have at least 10% overlap.   

• Blend zones should be entirely contained within a single Pan Tilt view if possible.   

• If overlap regions do not get calibrated correctly, verify that there is a Pan Tilt 

view for that region.   

• If there are “wavy” lines in many regions of the display after calibration, make 

sure the Advanced System Settings have been set correctly, especially the Center 

Pixel and the Focal Length of the particular camera being used (go to the 

Advanced → Advanced Settings → Camera Details menu). 

• If there are “wavy” lines over the edges of the display, you may need to use the 

Mask Tool to mask off the edges of the display. 

• Ideally, the camera should be placed in the center of the display (for example, 

for a dome display surface, the camera would be positioned right in the center of 

the dome and oriented towards the central eye point of the display).  If this is 

not possible, you will need to adjust the default eye point by changing the Pan 

Tilt Translation settings using the Advanced → Advanced Settings → Physical 

Setup menu. 

• If the camera is not oriented as described in Section 5 (the camera’s mount 

position does not coincide with the forward direction of the PTU), adjust the Pan 

Tilt Rotation Angle setting from the Advanced → Advanced Settings → Physical 

Setup menu.  For example, if the camera is rotated 180 degrees from its 

recommended position, set the rotation value from 0.0 to 3.14 (PI). 
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11 Advanced System Settings 
The Advanced System Settings menu (go to Advanced → Advanced Settings from the Sol 

Server menu) provides access to settings which are not frequently changed.  These 

settings are typically adjusted only during display system setup or if there are changes in 

configuration (a different camera, a new camera position, etc). 

 

Note that in a Multi-Display system each of the displays maintains their own set of 

configuration data.  Thus you need to select the Display tab you wish to edit before 

opening the Advanced Settings. 

 

IMPORTANT:  In order to make changes to the system settings, you must first 

unlock the system by toggling the “Lock” icon in the lower left hand corner of 

the dialog box.  Then, to adjust a value, right click on the value to bring up an 

edit box.  When you are finished making changes, click the “Save” button. 

11.1 Color Alignment/Warp Parameters 

 
 

11.1.1 Alpha Noise Coefficient 

The noise coefficient to use when blending channels.  Use 0 to turn off the noise pattern 

completely. 

11.1.2 Automatic Color Alignment (choose one) 

The Automatic Color Alignment System options determine how color alignment will be 

performed on each projector. 
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Tip:  If your projectors have a sRGB or Whiteboard option, it will typically 

produce the best results. 

• Camera Based When this option is enabled, additional color 

calibration images are displayed during calibration.  

These images are used to discover the color gamut 

capabilities of each projector, overlap them, and 

correct each one to this overlap region called the 

Common Gamut. 

• ICC Profiles ICC Profiles enables the use of industry-standard.  ICC 

files to calibrate the appearance of each display.  With 

a unique and accurate profile for each projector, the 

Sol Server can alter the output of each pixel so that 

colors appear consistent across the entire display even 

if the characteristics of individual projectors vary 

greatly. 

• Static Gamma  This option calculates the luminosity of each pixel in 

the overlapping areas based on a standard gamma 

curve.  This option is preferred if your projector’s 

output response can be modeled closely by a standard 

gamma curve.  Once enabled, the default gamma value 

is 2.2.  You can change the value by right clicking on a 

channel name and selecting Change Gamma. 

11.1.3 Blend Zone Brightness Enhancement 

Brightness enhancement for blending zones that appear too dark.  Increase this value to 

lighten blended areas. 

11.1.4 Clip Planes 

This setting changes the default shape of the view frustum for 3D applications.  The 

default near value is 1.  The default far value is 10,000.  Changing these settings will 

affect any 3D application that uses the Sol Realtime API providing it doesn't explicitly 

modify the clip planes internally. 

• Far Adjusts the far clip plane. 

• Near Adjusts the near clip plane. 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

37 

11.2 Camera Details 

 

11.2.1 60Hz Shutter Mode 

• 60Hz Shutter Mode Improves color alignment with DLP projectors. 

11.2.2 Camera/Lens Parameters 

• Camera/Lens Type Selection of the camera and lens combination can be 

made by right-clicking on the field to the right.  A 

dialog box will come up for the selection.  If ‘default’ is 

selected, all of the below parameters will still be able 

to be set.  If one of the pre-set camera/lens 

combinations is selected, only the relevant parameters 

will remain: 

 
• Center Pixel Optical center of the camera image 

((width-1) / 2, (height-1) / 2) 

• Focal length Focal length of the lens (measured in pixels) 

• Kappa One Primary radial distortion parameter 

• Kappa Two Secondary radial distortion parameter 

• Pixel size Physical size of image sensor pixels (in mm) 



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

38 

11.3 Image Border 

 

11.3.1 Soft Edges (choose one) 

This menu is used for displays where there is no intended overlap between 

projectors. (For example, if your display surface is an octagon, you may want only a 

single projector projecting onto each wall of the octagon.)  The Soft Edges option 

can be enabled and set with a distance parameter that describes how many edge 

pixels will be used to form the soft edge (intensity fall-off) around the entire 

projector.  This can help to minimize the effects of accidental overlap between 

adjacent projectors. 

 

• Off Default is off. 

• On  Typical falloff values range from 0-15 pixels. 

11.4 Network 

 
• Nameserver The IP address of the nameserver to use.  If this is not 

set, you will need to use IPv4 addresses throughout 

the Sol Server. 
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11.5 Pattern Generation 

 

11.5.1 Grid Resolution (choose one) 

This defines how dense the calibration grid will be.  Typically, a coarse dot pattern is 

sufficient.  Displays which use low resolution projectors or screens with significant 

curvature may benefit from a fine dot resolution. 

 

• Coarse This grid will have fewer calibration dots overall. 

• Fine This grid will contain more calibration dots overall. 

• Normal This grid is in between Coarse and Fine. 

11.5.2 Target Size (choose one) 

This is used to adjust the dimensions of each calibration target (dot) in the pattern.  

The general rule is to use Large dots for high resolution projectors and Small dots 

for low resolution projectors. 

 

• Large A large target dot will be used for calibration. 

• Medium A medium target dot will be used for calibration. 

• Small A small target dot will be used for calibration. 
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11.6 Physical Setup 

 
 

It is very important to have the proper values in Physical Setup in order to get good 

calibrations.  Note that any 3D vector or translation parameter will use the notation of 

(x, y, z).  We use a right-hand coordinate system, thus as you look at your screen the 

positive X axis goes to your right, the positive Y axis goes straight up, and the positive Z 
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axis comes toward you (negative Z goes toward the screen).  The coordinate of (0, 0, 0) 

is the center of your screen.  With a flat screen, it would be centered in x and y, and 

right on the screen.  For a spherical screen, (0, 0, 0) refers to the center of the sphere.  

And for a cylinder, (0, 0, 0) is at the center of the cylinder.  Keep this in mind when 

adjusting any of the following translations. 

 

• Camera Rotation Angle Angle of rotation for camera in radians.  The default is 

3.14, and should not be changed. 

• Camera Rotation Axis Axis of rotation for camera.  The default should not be 

changed. 

• Camera Translation The 3D translation from the Pan Tilt Unit’s center of tilt 

axis, to the nodal point of the camera (in millimeters).  

If there is no PTU, this is the translation from the 

mount point on the bottom of the camera to the nodal 

point. 

11.6.1 Display Surface Model (choose one) 

• Cylinder Choose this if your screen is part of a cylinder 

• Cylinder Up Axis A 3D unit vector defining the up axis of the cylinder 

• Screen Radius The radius of the cylinder in millimeters 

• Flat Choose this if your screen is flat 

• Width/Height Width and Height of the screen 

• Sphere Choose this if your screen is part of a sphere 

• Screen Radius The radius of the sphere in millimeters 

11.6.2 Eyepoint position 

• Eyepoint position This (x, y, z) vector specifies the eye position in 

millimeters in the display coordinate system (from the 

origin). 

11.6.3 Pan Tilt Manual Resolution 

The Pan Tilt resolutions are queried from the PTU and used as the defaults.  If those 

defaults need to be overridden, enable this option. 

 

• Disable Use the default Pan Tilt resolution. 

• Enable Use the defined resolutions for Pan and Tilt. 
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• Pan Resolution Resolution for panning if manual resolution is enabled.  

It specifies the number of mechanical steps required 

by the PTU per degree of pan rotation. 

• Tilt Resolution Resolution for tilting if manual resolution is enabled.  It 

specifies the number of mechanical steps required by 

the PTU per degree of tilt rotation. 

11.6.4 Pan Tilt Port (choose one) 

If this is set incorrectly, the Pan Tilt Unit will not be recognized.  The Sol Server must be 

restarted to recognize the PTU after a change to this parameter. 

 

• Serial Use when connecting the PTU’s RS-232 cable directly 

to the Sol Server. 

• USB Use when using a USB RS-232 Adapter with the Sol 

Server. 

11.6.5 Pan Tilt Rotation Angle 

• Pan Tilt Rotation Angle Angle of rotation for the PTU in radians.  See Pan Tilt 

Rotation Axis below for more explanation. 

11.6.6 Pan Tilt Rotation Axis 

• Pan Tilt Rotation Axis  Axis of rotation for the PTU.  The default for this is the 

Z-axis.  The Pan Tilt Rotational Angle default is 0.  Thus 

the default values work for a camera mounted upright.  

If your camera is mounted upside down, use a Pan Tilt 

Rotation Angle of 3.14 (a 180 degree rotation about 

the Z axis). 

11.6.7 Pan Tilt Software/Hardware Limits (choose one) 

The Pan Tilt minimum and maximum travel stops are queried from the PTU and used as 

the defaults.  If those defaults need to be overridden, enable this option. 

 

• Disable Use the default limits 

• Enable Use the defined limits for the PTU 

• Max Pan Maximum pan position value if manual limits are 

enabled. 

• Max Tilt Maximum tilt position value if manual limits are 

enabled. 
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• Min Pan Minimum pan position value if manual limits are 

enabled. 

• Min Tilt Minimum tilt position value if manual limits are 

enabled. 

11.6.8 Pan Tilt Translation 

• Pan Tilt Translation  The 3D translation from the center of the screen 

(which is the origin), to the PTU’s center of tilt axis (in 

millimeters).  If there is no PTU, this is the translation 

from the center of the screen to the bottom of the 

camera (which is usually on a tripod, or hung from the 

ceiling). 

12 First Calibration 

12.1 Before Calibrating 

If you have a Windows Client with more than one channel, you need to make sure the 

Task Bar disappears during calibration.  You do this by doing the following: 

 

• Right-click on the task bar and select “Properties” 

• Check the “Auto-hide the taskbar” box 

• Uncheck the “Keep the taskbar on top of other windows” box 

12.2 Calibrate the Display 

If you are using multiple Displays, you need to calibrate each Display separately.  To do 

this, select the tab of the Display you want to calibrate, and press the “Calibrate” 

button. 

 

If you are using only one Display, there are no tabs to select.  Simply press the 

“Calibrate” button to start calibration. 

 

When calibration starts, a series of patterns will be projected onto the display surface 

while the camera captures images.  The calibration progress bar on the interface will 

indicate when the calibration process is complete.  During this process, do not disturb 

the environment (don’t walk in front of the projectors or camera, don’t turn on the 

lights, etc.). 
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Once the test patterns stop and the “Optimizing” green screens are shown, it is okay to 

be in front of the camera.  Calibration is continuing, but is no longer getting data from 

the camera. 

 

   

12.3 Verify Calibration Results 

Click the "Test Pattern" button.  The World Alignment Tool interface pops up and a 

gridded sphere is rendered across the entire display.  The grid is used to verify the 

accuracy of the most recent calibration results.  Each line of the grid should be straight 

and aligned correctly with the lines of neighboring projectors. 
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12.4 Stop the Test Pattern Program 

Exit the program by clicking the close icon located on the upper right hand corner of the 

interface, or by clicking the “Halt Test Pattern” button on the Sol Server interface. 

12.5 Calibration Report 

The calibration report is a way to see details in one place on the latest calibration.  It is a 

report that comes up automatically after each calibration.  If you do not want it to come 

up automatically, you can uncheck the “Show after every calibration” box in the lower-

left corner of the report viewer.  You can bring up the latest calibration report at any 

time by selecting the Sol Server’s Tools → View Calibration Report menu option. 

 

License information is displayed including the User's name on the license key, the 

number of licensed channels/simulators and whether or not the license key is valid. 

 

Some information is shown for each Display.  Highlights are shown here, but with each 

release, other important information will show up in this report as well. 

 

• Calibrated Image An image of the calibrated display comprised of the 

individual channels. 

• Display Size The total size of the Display in pixels (width x height) 

• Camera Information  

• Name/ID The name and unique ID of the camera used for this 

Display. 

• Size The size in pixels of the camera’s captured images 

• Camera Shutter Value The shutter value used for the calibration.  If too 

high or low, it will affect the quality of the calibrated 

display (or prevent a successful calibration 

altogether). 

• Camera Gain Value The gain value used for the calibration.  If too high 

or low, it will affect the quality of the calibrated 

display (or prevent a successful calibration 

altogether). 

• Auto Shutter The ideal shutter value computed using the 

automatic shutter/gain value detector. 

• Auto Gain The ideal gain value computed using the automatic 

shutter/gain value detector. 
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Each Channel’s information is also part of the report: 

 

• IP Address  

• ScreenID  

• Resolution Display resolution in pixels of the Channel 

• Area Masked Off The percentage of the Channel that has been 

masked off via the Mask Tool. 

• Overlapped Area Percentage of the current display that is overlapped 

with other Channels.  10-20% overlap is ideal. 

• Pan Tilt Lists each of the (pan,tilt) positions in the sequence 

used to do the calibration. 

• Number of Calibrations The number of times a calibration has been 

performed since it was installed or upgraded. 

• Time to Calibrate The amount of time it takes to calibrate the Display. 

• Grid Tension These diagnostic values are indicators of how close 

the display is to being calibrated on the initial and 

final stitching of the channels. A low value is ideal. If 

a high value is seen, it indicates that the capture 

process was not ideal.  Usually this means the focal 

length (Tools → Advanced Settings → Camera 

Settings → Focal Length) of the camera has to be 

adjusted. 

13 Automatic Color Alignment System 
The Automatic Color Alignment System (ACAS) brings multiple projectors with differing 

color profiles into a quality alignment that is difficult or impossible to detect with the 

human eye.  Over time the imaging elements of a given projector age, leading to 

decreased brightness and/or discoloration.  When multiple projectors are used in a 

system, these aging artifacts always lead to different regions of an immersive display 

having noticeably varying appearances.  The ACAS system finally eliminates this problem 

automatically using the either the Firefly MV camera or industry-standard ICC Color 

Profiles. 

13.1 Static Gamma 

If the blending version is set to Static Gamma, no color alignment techniques will be 

used.  Static Gamma bypasses any color look-up tables and calculates the luminosity of 

each color component of each pixel in the overlap zones by a standard gamma function 

(output = input gamma).  Each channel can be set to a different gamma value. 
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13.2 ICC Color Profiles 

The International Color Consortium (ICC) has defined an open specification for profiling 

the color output of a device.  An ICC Profile stores information about the color 

capabilities of a device (in this case, a projector).  From an ICC Profile it is possible to 

determine the entire gamut of colors a device is capable of producing.  The ICC Profile 

specification is an ISO standard and is very commonly used across many industries that 

require reliable color reproduction.   

  

Mersive now takes advantage of this industry standard method of ensuring color 

consistency with the ability to accept an ICC profile for each channel.  With a unique and 

accurate profile for each projector, the Sol Server can alter the output of each pixel so 

that colors appear consistent across the entire display, even if the characteristics of 

individual projectors vary greatly. 

13.2.1 Instructions for Use 

To enable color correction via ICC Profiles, follow these steps: 

 

1. In the Advanced Settings menu, expand Color/Warp Parameters-> [Automatic 

Color Alignment].  Select "ICC Profiles" from the options. 

2. On the main Sol Server interface, right click on one of the channels and select 

the option "ICC Profile: …". 

3. A new form opens with a list of channels on the left and available ICC Profiles on 

the right.  You will need to import your ICC Profiles.  The easiest way to do so is 

to store them on a USB thumb drive and plug the drive into the Sol Server.  Once 

that is done, select File -> "Import ICC Profiles" and navigate to the profiles you 

with to import and select "Open".  You can select multiple files if you wish. 

4. You now have all the ICC Profiles visible on the right hand list.  The next step is 

to associate Channels with Profiles.  Do this by selecting a channel name first, 

then clicking on the ICC Profile you wish to associate with it.  Do this for each 

channel. 

5. Click OK to save the changes and close the form. 

6. You are now ready to use your display with color correction. 

NOTE: Mersive does not provide a method for creating ICC profiles; we simply 

use the profiles after they are created.  There are many software and 

hardware packages for creating profiles available from third-party vendors. 

13.2.2 Troubleshooting 

If your displays do not appear to be color corrected, try the following: 
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• Make sure ICC Profiles is selected in Advanced Settings 

• Make sure you’ve captured accurate ICC profiles for each channel 

• Make sure you’ve assigned each channel to the ICC profile you’ve captured for 

that channel 

13.2.3 Tips 

• To create ICC Profiles you will need a color sensing device and a software 

package capable of creating profiles.  We recommend using a 

spectrophotometer rather than a tristimulus device such as a colorimeter.  A 

spectrophotometer can report colors more accurately and therefore provide 

superior results. 

• When profiling projectors, make sure each profile is captured under very similar 

conditions.  These conditions include: 

o Amount of ambient light in room (little to no ambient light is preferred) 

o Distance of spectrophotometer to screen 

o Angle of spectrophotometer to screen 

• Be sure to let projectors "warm up" completely before capturing profiles. 

• Be sure not to point the spectrophotometer at a "hot spot" on the screen. 

  

NOTE:  The quality of color correction is completely dependent on the 

accuracy of the information contained in the ICC Profile, so please make every 

effort to capture the profiles properly. 

13.3 Camera-based Color Alignment 

Mersive’s Automatic Color Alignment System enables the Sol Server to improve the 

visible colors of each projector using the same color camera used for geometric 

calibration.  This alignment system works in dark simulator environments or display 

rooms with a significant amount of ambient light.  Results are good from a single camera 

view, multiple cameras, or using our Pan-tilt unit.  Just be sure to stick to the tips for 

getting the best possible results. 

13.3.1 Instructions for Use 

To enable color correction via the Firefly MV camera, follow these steps: 

 

1. In the Advanced Settings menu, expand Color/Warp Parameters-> [Automatic 

Color Alignment].  Select "Camera Based" from the options and restart the Sol 

Server. 
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2. After performing Geometry Calibration, click the radio button for Color 

Alignment. 

3. Press Calibrate. 

4. When prompted, adjust the aperture ring of your camera until a check box is 

displayed and click it to continue. 

13.3.2 Tips 

• Be sure to let projectors warm up completely before pressing “Calibrate”. 

• Results are best for projection surfaces that directly face the camera. 

• Turn on sRGB or Whiteboard mode on your projectors for the best results. 

• Optional: Results will be highest quality if “white boost” is disabled. 

14 World Alignment 

Once a display is calibrated, the World Alignment Tool may be used to adjust the 

orientation of a model such that it is aligned to a desired location/orientation in the 

world.  For example, if the camera used to calibrate the display was oriented with a non-

zero roll, horizontal lines in the application running on the display may not be parallel to 

horizontal lines in the world.  The World Alignment Tool can be used to correct for this.  

In addition, this tool may be used to adjust the display’s field of view. 

14.1 Start World Alignment Tool 

If you are using a Multi-Display system, select the Display tab you wish to work on. 

 

Click the "Test Pattern" button on the Sol Server interface.  The World Alignment 

interface pops up with a gridded sphere.  This sphere is also shown across the display.   

14.2 Adjust Orientation and/or Field of View (FOV) 

Adjust the orientation of the sphere by rotating the "Pitch", "Yaw", and "Roll" dials to 

the desired settings.  Alternatively, use the left mouse button to click on the sphere and 

drag it to the desired orientation. 

 

Adjust the FOV of the Display by using the “+/-” buttons under the Horizontal/Vertical 

FOV labels.  Alternatively, you can type in the desired FOV values. 

14.3 Save Orientation and/or Field of View 

Click "Save Orientation" to save the orientation. 
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Click “Save FOV” to save the field of view. 

14.4 Stereo Displays 

If a Display has been configured as part of a stereo pair, a Stereo Eye Shift configuration 

box with default eye point offsets will be shown for each Display on the World 

Alignment Tool interface.  The World Alignment Tool will run both Displays 

simultaneously with the respective offsets.  (To disable stereo mode for the World 

Alignment Tool so that each Display may be viewed individually, go to the Multi-Display 

Configuration dialog box and set the “Stereo Pair” entries to “—None –“.) 

14.5 Exit 

Exit the World Alignment Tool by clicking the close icon located on the upper right 

corner of the interface, or by clicking the “Halt Test Pattern” button on the Sol Server 

Interface. 

 

15 Running an Application 
The application you will run on a multi-projector display must already be Mersive 

Enabled.  Your software provider can tell you if they have integrated the Sol RealTime 

API into your application.   
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If you are interested in using the Sol RealTime API to enable your own application for a 

calibrated multi-projector display, you can use the API that comes shipped with each Sol 

Server System.  See the “Sol RealTime API User’s Guide” for more information.   

IMPORTANT:  Each Client Computer in the display must have a copy of the 

Mersive Enabled application. 

15.1 Integrated Application Compatibility 

With Sol Server Release 1.6.0, an application that has been integrated with a Sol 

RunTime API Release that is less than 1.6.0 will only run correctly if the Sol Server is 

licensed for a single Display.  If, however, the Sol Server is licensed for more than one 

Display, thus enabling a Multi-Display configuration, the integrated application must 

include an extra function call (see the Sol RunTime API) and must be recompiled with 

the 1.6.0 API.  

 

Also, if using Sol Server Release 1.6.0 with an integrated application that is less that 

1.6.0, the Blending Version in the Advanced System Settings menu of the Sol Server 

must be set to the "Captured Color Curves" option in order for the application to render 

correctly. 

15.2 Example 

EXAMPLE:  Running a MetaVR VRSG Application 

Perform the following configuration steps for each Client Computer: 

1. First perform the normal MetaVR configuration. 

2. Click on the Mersive tab found in the VRSG Dashboard.   

3. Type the Sol Server’s IP Address into the “Server IP” text box.  This IP 

Address must be the IP Address that was set in the Configuration Window 

of the Sol Server. 

4. Type the channel name in the “Node Name” text box.  The name must 

correspond to the channel name that was assigned to this Client 

Computer’s IP Address in the Configuration Window. 

Continuing with the example, if we are configuring the Client Computer 

whose IP Address is “192.168.1.13”, the Node Name must be entered as 

“render4” because this is the channel name we assigned to that IP 

Address when configuring the Sol Server. 
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Once configuration is complete for each channel, click “Start VRSG” on the 

main machine (which will be one of the Client Computers) on which the 

multi-channel server is running.  This will launch the application on all the 

Client Computers. 
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Running a Mersive Enabled MetaVR Application on a 4-Projector Curved Display 

16 Using the Image Viewer 
The Image Viewer allows a single image to be rendered across a calibrated display.  

16.1 Start Image Viewer 

If you are using a Multi-Display system, select the Display tab you wish to work on. 

 

Select Tools → Image Viewer from the Sol Server's menu options.  The Image Viewer 

interface is shown with an image window overlaid on top of a representation of the 

calibrated display surface. 

16.2 Select Shape 

By default, the image is assumed to be rendered for a planar display surface.  To set the 

image for a curved display surface, select Image → Select Shape → Curved from the 

menu. 
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16.3 Select Directory of Images 

All images to be loaded must be in a single directory.  Insert a USB stick or CD with the 

image directory into the Sol Server.  Go to the File → Open Directory menu option and 

select a directory of images.  Once selected, the first image in the directory will be 

loaded onto the image window.  All the images in the directory will then be transferred 

to each of the display clients.  Once image transfer is complete, the clients will load and 

display the first image.  Note that any non-image files found in the directory will be 

rendered as solid black on the display. 

NOTE:  A default directory called "Samples” has been provided that contains 

a set of sample images that may also be selected from the list of directories. 

16.4 Position Image 

Position the top left corner of the image window by clicking the left mouse button at the 

desired location.  Once a location has been fixed, it is recommended that you click the 

"Lock Top Corner" check box under “Image View” to prevent the window position from 

changing.  Use the rotation/scaling tools under “World View” to adjust the world view in 

order to better position the image window.  Alternatively, use the right mouse button to 

rotate the world view. 

16.5 Adjust Image Size 

Resize the image by pressing the left mouse button on the bottom right corner of the 

image window and dragging to the desired size.  The aspect ratio of the image is 

retained.  Alternatively, use the zoom tools under "Image View" to resize the image.   

16.6 Playback 

To switch to the next/previous image in the sequence, click the forward/backward icons 

under "Playback".  To automatically play a sequence of images, set the timer to the 

desired number of seconds per image and then click the play icon. 

16.7 Exit 

Exit the Image Viewer by clicking the close icon located on the upper right hand corner 

of the interface.  Alternatively, select File → Halt Client Applications from the Sol Server 

Interface to halt the Image Viewer server and clients. 

NOTE:  Images larger than 4K in width or height are automatically rescaled 

(the original aspect ratio is maintained). 
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Image Attributions:  

 

The sample images provided in the Image Viewer have been obtained from the 

following sources: 

 

• Johnathon Jaynes 

• Øyvind Kolås  

• Panoscan  

• NASA and The Visible Earth  

17 Create/Restore Migration File 
These menu options allow you to save the current Sol Server state (configuration and 

data) to a file, such that it can be restored (in the event of a Sol Server upgrade).  Thus if 

you are upgrading from one Sol Server release to another, you can avoid having to re-

enter all of your settings by first saving them, upgrading the Sol Server, and then 

restoring your settings.  



 
 

 

Sol Server User’s Guide – Copyright 2010, Mersive Technologies, Inc. 

Mersive Technologies Confidential – Do Not Distribute 

 

56 

17.1 Create Migration File 

Select the Sol Server’s Tools → Create Migration menu option.  You will be prompted for 

a location to save the information. 

 

NOTE: To save to a usb key, save the file to /mersive/images/usb1 

17.2 Restore Migration File 

Select the Sol Server’s Tools → Restore Migration File menu option.  You will be 

prompted for a configuration file to restore.  Confirm that you want to overwrite your 

current configuration. 

 

NOTE: To restore from a usb key, look for your file in /mersive/images/usb1 

NOTE: The license key must be valid for the number of channels/displays on 

the Sol Server being restored.  If this is not the case, the restoration will fail. 

Once the settings have been restored, the Sol Server will automatically restart to 

complete the process. 
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18 Troubleshooting 
If you are having any difficulty with the Sol Server, please see our FAQ at: 

  

http://www.mersive.com/Support/faq.html  

18.1 Rebooting the Sol Server 

There might be a time where you need to reboot the Sol Server.  You can do this using 

the “Reboot Hardware” option from the Sol Server “File” menu.  If for some reason this 

does not work, you can press and hold the power button on the Sol Server to initiate a 

shutdown.  After this, press the power button once to start it back up. 

18.2 Camera Image Torn 

Sometimes during the start up of the Sol Server the camera fails to initialize its internal 

image buffer properly.  This can result in failed geometry calibration.  Verify before each 

calibration attempt that the view from the camera is whole and complete using the 

“Camera Preview” window.  If the image appears incomplete or out of order (torn), 

restart the Sol Server.  If this fails to resolve the torn image, disconnect and reconnect 

the USB cable from the Firefly MV and restart the Sol Server. 

18.3 Camera Not Detected 

Sometimes the camera is plugged in correctly, but the software cannot detect the 

camera.  If this happens, unplug the camera, wait a few seconds, plug it back in, and 

restart the Sol Server.  If you are using a Sol Server that has both Firewire 400 and 

Firewire 800 inputs, use the 800.  If using a Pan-Tilt Unit with the Sol Server, make sure 

the PTU port in Advanced Settings is set correctly as well. 

19 Contacting Mersive 

19.1 Email 

You can contact our support staff by using the following email address: 

 

support@mersive.com 

 

Look to the next section to see how you can get diagnostic information to the support 

staff as well. 
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19.2 Send Diagnostic Information to Mersive 

If you are having difficulties doing a calibration, you can send diagnostic information to 

our support team and they will attempt to help you.  Select Help  → Send Mersive 

Diagnostic Information to initiate the transfer of the diagnostic information. 

 

NOTE: The Sol Server must have Internet access for this option to work. 

 

If there are problems communicating to the Internet, you will be given an option to save 

the information to a USB drive.  A files size limit of 200MB is enforced. 
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20 User Notes 
 


